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Welcome to This Guide
This guide describes how to use the HP SOA Systinet Customization Editor to edit the SDM configuration
and the user interface of an installation of SOA Systinet. You can use the Customization Editor to modify
the model, its registry mappings and certain UI elements.

How This Guide is Organized

HP SOA Systinet Customization Editor is a set of Workbench features that enable you to edit the SDM
configuration and the user interface of an installation of SOA Systinet. You can use the Customization Ed-
itor to modify the model, its registry mappings and certain UI elements. Modifying create an extension to
SOA Systinet, and this part explains how to deploy these extensions.

This part includes the following chapters:

Getting Started on page 11. Introducing and configuring the Customization Editor, its main features, and
the customizable elements of SOA Systinet.

Manipulating Artifact Types on page 33. Customizing the attributes, properties and appearance of artifacts.

Manipulating Properties on page 53. Creating and modifying properties and property groups.

Configuring the SOA Systinet UI on page 65. Customizing the main tabs of SOA Systinet and creating new
UI elements.

Creating and Using Components on page 81. Creating customized Java and JSPs and using these components
with SOA Systinet.

Modifying Taxonomies on page 91. Modifying the set of available taxonomies.

Deploying an Extension to SOA Systinet on page 93. Preparing and deploying your extension to SOA
Systinet.

User Interface Reference on page 101. A guide to the Customization Editor user interface.
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Document Conventions

The typographic conventions used in this document are:

Script name or other executable command plus mandatory arguments.run.bat make

A command-line option.[--help]

A choice of arguments.either | or

A command-line argument that should be replaced with an actual value.replace_value

A choice between two command-line arguments where one or the other is
mandatory.

{arg1 | arg2}

Operating system commands and other user input that you can type on the
command line and press Enter to invoke. Items in italics should be replaced
by actual values.

rmdir /S /Q System32

Filenames, directory names, paths and package names.C:\System.ini

Program source code.a.append(b);

An inline Java or C++ class name.server.Version

An inline Java method name.getVersion()

A combination of keystrokes.Shift-N

A label, word or phrase in a GUI window, often clickable.Service View

A button in a GUI window.OK

Menu choice.New->Service

Documentation Updates

This manual's title page contains the following identifying information:

• Software version number

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software
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To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/

Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (http://h20230.www2.hp.-
com/svi_partner_list.jsp), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web site and use
the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products formerly produced
by Mercury, we encourage you to visit the Mercury Customer Support Web site at: http://hp.-
com/go/hpsoftwaresupport.

• For the latest information about support processes and tools available for products formerly produced
by Systinet, we encourage you to visit the Systinet Online Support Web site at: http://www.systinet.-
com/support/index.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

http://www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support tools. As a
valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests
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• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To find more information about access levels, go to: http://h20230.www2.hp.com/new_ac-
cess_levels.jsp

To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html
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1 Getting Started

The Customization Editor is used to create extensions to the core SOA Systinet configuration. The core
configuration itself is not modified. Instead, SOA Systinet includes a utility for adding extensions to the
configuration.

This chapter describes:

• Introduction to the Customization Editor on page 11 gives an overview of the use of the Customization
Editor.

• Customizable Elements of SOA Systinet on page 12 describes the elements of SOA Systinet that are
configurable using the Customization Editor.

• Creating an Extension Project on page 17 describes how to start a new project to configure SOA Systinet.

• Introduction to the User Interface on page 20 explains the main features of the Customization Editor
user interface.

• Navigating the Customization Editor on page 22 describes the layout of the Extension Explorer – the
main navigation view in the editor.

• Customization Editor Menu Options on page 28 describes the Customization Editor options in the Eclipse
drop-down menus.

• Searching the Extension on page 30 explains how to use the search function to find elements in the ex-
tensions.

• Saving Modifications on page 32 describes how to save your modifications.

Introduction to the Customization Editor

SOA Systinet is distributed with a preconfigured data model and user interface. For typical deployment
scenarios, both need to be customized to fit an organization specific environment.
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HP SOA Systinet Customization Editor provides a mechanism to customize both the model and the appear-
ance of the user interface, implement those changes and keep them isolated in a so-called extension package
that can then be re-applied during a re-installation or upgrade of SOA Systinet.

The overall process of customizing SOA Systinet is as follows:

1 Use the Customization Editor to:

• Modify the data model and user interface as described in:

• Manipulating Artifact Types on page 33

• Manipulating Properties on page 53

• Configuring the SOA Systinet UI on page 65

• Creating and Using Components on page 81

• Modifying Taxonomies on page 91

• Save your modifications to a stand-alone extension package file as described in Exporting the Ex-
tension Project on page 93.

2 Use the Setup Tool provided with SOA Systinet to apply the extension package to an installation of
SOA Systinet as described in Applying Extensions on page 94.

Special care must be taken when modifying artifacts that already have instances in the repository.
For example, a new installation already contains the person artifact administrator. Removing
properties from an artifact type with instances or adding a new required property without a default
value may cause instability in SOA Systinet. The Customization Editor should prevent this if the
SOA Systinet server is running during modification.

Customizable Elements of SOA Systinet

The Customization Editor enables you to modify almost any aspect of an installation of SOA Systinet.
These aspects consist of two main groups:
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• SDM Entities are the building blocks that represent the types of entity that exist in the repository defined
by the SOA Definition Model. These are described in more detail in SDM Elements on page 13.

• UI Entities are the elements of the SOA Systinet user interface. These are described in UI Elements on
page 14.

SDM Elements

The Customization Editor deals with four types of entity in the SDM configuration of SOA Systinet:

• Artifacts are the basic building blocks of SOA. Every entity in the repository is an instance of an artifact.
Each type of artifact is defined by an artifact type in the SDM. Artifact types are further categorized
into artifact packages. These packages are abstract artifact types that do not have instances in the repos-
itory but instead define groups of artifacts.

Artifact types and packages are visible in the Artifact Types branch of the Extension Explorer (see
Artifact Types on page 24) and artifact type procedures are described in Manipulating Artifact Types
on page 33.

• Properties are the attributes of artifacts. Properties are the labels that distinguish one instance of an
artifact from another. For example, all artifact instances have the name property but every artifact has
a different name.

Properties are visible in the SDM Details branch of the Extension Explorer (see SDM Details on page
25) and property procedures are described in Manipulating Properties on page 53.

• Property Groups enable properties to be organized and added to artifacts as a group instead of indi-
vidually. For example; name, address, and telephone number could be organized into a contact details
property group and then whenever a new artifact type is created that represents a person, the group can
be added to it instead of the individual properties.

Property Groups are visible in the SDM Details branch of the Extension Explorer (see SDM Details
on page 25) and property group procedures are described in Manipulating Properties on page 53.

• Taxonomies are categorization groups that each contain a set of values within a single category. For
example, office location could be a taxonomic group containing a set of values representing each office
in an organization.
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Taxonomies are visible in the Taxonomies branch of the Extension Explorer (see Taxonomies on page
27) and taxonomy procedures are described in Modifying Taxonomies on page 91.

UI Elements

Two types of SOA Systinet pages are configurable:

• The main SOA Systinet tabs.

• The artifact detail and browse pages.

The main SOA Systinet tabs consist of the tab heading, a menu on the left and a set of portlets in the main
area of the screen:

Figure 1. SOA Systinet Tab

Chapter 114



The two configurable elements on SOA Systinet tabs are:

• Navigation Menu

The navigation menu is organized into navigation groups and actions.

The details for each SOA Systinet tab are accessible in the User Interface->SOA Systinet tab->Navigation
branch of the Extension Explorer (see User Interface on page 26).

All the navigation actions in your extension are accessible in the User Interface->UI Details->Navig-
ation Actions branch in the Extension Explorer (see User Interface on page 26).

Configuring the navigation actions of a SOA Systinet tab, creating and modifying navigation actions,
and organizing navigation actions into groups are described in Configuring the SOA Systinet UI on
page 65.

• Portlets and Feeds

SOA Systinet tabs contain portlets in the main area of the screen.

The details for each SOA Systinet tab are accessible in the User Interface->SOA Systinet tab->Portlets
branch of the Extension Explorer (see User Interface on page 26).

All the portlets in your extension are accessible in the User Interface->UI Details->Portlets Definitions
branch in the Extension Explorer (see User Interface on page 26).

Configuring the portlets of a SOA Systinet tab and creating new portlets are described in Configuring
the SOA Systinet UI on page 65.

Artifact pages consist of the page heading, a set of contextual menus and the main layout of the page:
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Figure 2. SOA Systinet Artifact Page

The two configurable elements on artifact pages are:

• Contextual Action Menus

The contextual menus are organized into UI groups and contextual actions.

The details for each artifact type are accessible in the Service Catalog UI and Tools UI tabs of the
relevant artifact editor (see Artifact Types on page 24).
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All the contextual actions and groups of actions in your extension are accessible in the User Interface-
>UI Details->Contextual Actions and Contextual Action Groups branches in the Extension Explorer
(see User Interface on page 26).

Configuring the contextual menus of an artifact page is described in Manipulating Artifact Types on
page 33. Creating context actions and organizing them into groups is described in Configuring the SOA
Systinet UI on page 65.

• Page Layout

The page layout of artifact detail pages can be configured.

The details for each artifact type are accessible in the Service Catalog UI and Tools UI tabs of the
relevant artifact editor (see Artifact Types on page 24).

Configuring the layout of an artifact page is described in Manipulating Artifact Types on page 33.

Creating an Extension Project

The first step in customizing your installation is to create an extension project in the Customization Editor.
This is your workspace where you make all your modifications.

To create an extension project:

1 In the File menu, select New–>HP SOA Systinet–>Extension Project.

2 Complete the dialog with parameters:

DefinitionParameter

Use Browse to select the SOA Systinet platform installation folderPlatform Home

Use Browse to select the extension folder in your SOA Systinet
installation (populated by default based on the Platform Home
input

Extension Folder

Select Develop JSPs to enable component development in Custom-
ization Editor

Develop JSPs

Use Browse to select the deployment directory for your application
server (usually JBOSS_HOME\server\default\deploy)

JBoss Deploy Directory
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DefinitionParameter

Input the JNDI Port for your application server.JBoss JNDI Port

Only JBoss is supported for the development of components and tasks in this release.

Click Next. A page opens for selecting an SOA Systinet server for the project.

3 Select whether to add a new server to the project or use a server you have already defined. This step
does not appear if there are no defined servers. If you select an existing server, click Next and go to
Step 5.

4 Type in the name and URL of an SOA Systinet server. Enter the username and password you use for
this server. You can save the password and validate your connection to the server.

5 Select one of the three options:

• Create a new extension project from scratch – this creates an empty extension containing no elements
at all. This is the default option for most uses of the Customization Editor.

• Edit an existing extension – open an extension for modification.
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• Create a new extension from an existing one – use an existing extension as the basis of a new one.
If you use this option, the existing extension must be removed from the extensions folder before
you deploy the new extension.

For the last two options select an extension from the extension folder or use Add Extension to select
one from another location.

Click Next.

Edit extension skips to Step 8.

6 For the create options complete the dialog with parameters:

DefinitionParameter

The name of your extension projectName

The prefix used for the URI when creating a new artifact type or propertyNamespace

A description of your extension projectDescription

The extension version numberVersion

The unique identifier of the extensionURI

Click Next to select an extension dependency.

7 For the create options you can optionally add dependencies on other extensions. All extensions are
dependent on the core extension.

Select extensions from the list or use Add extension to add an extension from outside the default ex-
tensions directory to the list. Click Next to set the extension properties.

8 Complete the dialog with the following parameters:

DefinitionParameter

The name of the new extension projectProject Name

Optionally, deselect Default Location and use Browse to select a new workspace
directory

Location
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9 Click Finish to create the project.

In the HP SOA Systinet perspective, the Extension Explorer (see Navigating the Customization Editor
on page 22) now displays a view of your extension which contains not only the elements contained in your
extension project but all the elements from any other extensions that your project depends on.

Introduction to the User Interface

The default HP SOA Systinet perspective is split into four sections with menu options across the top. On
the left is the Extension Explorer, a tree view of the SDM configuration. The main section contains the
details of the item highlighted on the left. Multiple editors can be open in this main section and the function-
ality varies depending on the editor. On the bottom left is the Server Explorer, listing SOA Systinet servers.
In the bottom-right are views for tracking problems, actions, and searches.
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Figure 3. Customization Editor UI

The details of the user interface are described in:
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• Navigating the Customization Editor on page 22. The Extension Explorer is the main navigation view
for the Customization Editor.

• User Interface Reference on page 101 describes the functionality of each editor and view in the main and
bottom-right sections.

• Server Explorer on page 29 describes the server context menu in the Server Explorer.

Navigating the Customization Editor

The Extension Explorer represents a tree view of the extension project that you are currently working
with. It includes all the elements from extensions that it depends on as well.

Note:Your changes are stored in your extension. You can change the labels and descriptions of
elements from dependent extensions but you cannot delete them or make any other changes. If
you want to delete an element from a dependent extension then deprecate it.
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Figure 4. Extension Explorer View

Double-clicking an item in the tree will open the relevant editor in the main section and also open/close a
branch.

Right-clicking an element opens a context menu of options relevant to the particular element.
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The tree is split into the extension root and five branches representing different elements of your extension.
The functionality within each element is described in the following sections:

• Your Extension on page 24 describes the top level object in the extension.

• Artifact Types on page 24 contains the hierarchical structure of the artifact types and packages within
the extension.

• SDM Details on page 25 contains properties and property groups.

• User Interface on page 26 contains the customizable elements of the SOA Systinet user interface.

• Taxonomies on page 27 accesses the categorization groups available within this extension.

• project.xml on page 27 is configuration of the current extension project.

Your Extension

The extension name is the root element of the project.

The right-click context menu contains the option to Build Extension which creates a jar containing your
extension ready to import to SOA Systinet (see Deploying an Extension to SOA Systinet on page 93).

Artifact Types

The Artifact Types branch contains the artifact types organized into a hierarchical structure reflecting the
SOA Model.

Each element below Artifact Types is a type of artifact or artifact package and the right-click context menu
has the following functionality:

• New Artifact Type/Package creates a new artifact type as described in Creating an Artifact Type or
Package on page 33.

• Open Artifact Type/Package opens the artifact editor for the selected element with the name of the
element as the editor title. The functionality of this view is described in Artifact Editor on page 102.

• Deprecate Artifact Type/Package. After confirmation, the artifact type becomes inactive in the extension
project and is hidden in the SOA Systinet UI.
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• Undeprecate Artifact Type/Package. After confirmation, the artifact type reactivates in the extension
project.

• Delete Artifact Type/Package. After confirmation, the artifact type is removed from the extension
project.

An artifact package is an artifact type that serves as a group of other artifacts. They do not have
instances in the repository and just serve to organize a hierarchy of artifact types in the SDM.

SDM Details

The SDM Details branch contains two element types:

• Property Descriptors of which there are three types:

• Primitive Property

• Relationship Property

• Taxonomy Property

The parent branches contain one context menu option:

• New Property opens a dialog described in Creating a Property on page 53.

Within each parent element is the list of properties of that type. The context menu for properties contains
the following options:

• Open Property opens the property editor for the selected element with the name of the element as
the editor title. The functionality of this view is described in Property Editor on page 113.

• Deprecate Property. After confirmation, the property becomes inactive in the extension project
and is hidden in the SOA Systinet UI.

• Undeprecate Property. After confirmation, the property reactivates in the extension project.

• Delete Property. After confirmation, the property is removed from the extension project.
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• Find Usage opens a search view displaying all the artifacts and property groups that contain this
property as described in Search View on page 136.

• Property Groups

The context menu of the parent element only has one option:

• New Property Group opens a dialog described in Creating a Property Group on page 62.

The context menu for each property group has these options:

• Open Property Group opens the property group editor for the selected element with the name of
the element as the editor title. The functionality of this view is described in Property Group Editor
on page 117.

• Delete Property Group. After confirmation, the property group is removed from the extension
project.

• Find Usage opens a search view displaying all the artifacts that contain this property group as de-
scribed in Search View on page 136.

User Interface

The User Interface branch contains a branch for each tab in the SOA Systinet UI and a UI Details branch
containing UI elements.

The branch for each SOA Systinet tab contains two elements:

• Navigation. Double-click to open the view for that SOA Systinet tab allowing you to customize the
menus in SOA Systinet. The functionality of the Navigation editor is described in Navigation Editor
on page 118.

• Portlets. Double-click to open the view for that SOA Systinet tab allowing you to customize the portlets
that are available on the selected SOA Systinet tab. The functionality of the Portlets editor is described
in Portlets Editor on page 120.

UI Details contains the following elements:
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• Components are elements called by the SOA Systinet UI to perform a particular function. Double click
to open the view described in Components Editor on page 122 or right-click and select New Component
to start the dialog described in Creating a Component on page 81.

• Contextual Action Groups allow you to group context actions together and add them to the context
options in the SOA Systinet UI. Double-click to open the view described in Contextual Action Groups
Editor on page 123 or right click and select New Context Action Group to start the dialog described in
Creating a Context Action Group on page 75.

• Contextual Actions are menu options available within artifact and service pages in the SOA Systinet
UI. Double click to open the view described in Contextual Actions Editor on page 124 or right click and
select New Context Action to start the dialog described in Creating a Contextual Action on page 73.

• Navigation Actions are the links in SOA Systinet that navigate between pages. Double click to open
the view described in Navigation Actions Editor on page 126 or right click and select New Navigation
Action to start the dialog described in Creating a Navigation Action on page 70.

• Perspectives control the views available to users in SOA Systinet. Double click to open the view de-
scribed in Perspectives Editor on page 127 or right click and select New Perspective to start the dialog
described in Creating a Perspective on page 77.

• Portlets Definitions are the components in the main section of SOA Systinet pages. Double click to
open the view described in Portlets Definitions Editor on page 128 or right click and select New Portlet
to start the dialog described in Creating a Portlet on page 78.

• Tasks are UI wrappers for components. Double click to open the view described in Tasks Editor on
page 129 or right-click and select New Task to start the dialog described in Creating a Task on page 83.

Taxonomies

The Taxonomies branch allows you to control the taxonomies that are available within your extension
project. Double-click to open the view described in Taxonomies Editor on page 131.

project.xml

The project.xml branch accesses the view allowing you to configure the current extension project as described
in project.xml Editor on page 132.
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Customization Editor Menu Options

The menus in Customization Editor are the normal Eclipse menus with the addition of specific functionality
for the Customization Editor.

The extra menu options in the Customization Editor include:

• File->New->HP SOA Extension Project to start a new project as described in Creating an Extension
Project on page 17.

• File->New->Artifact Type to create an artifact type as described in Creating an Artifact Type or
Package on page 33.

• File->New->Artifact Package to create an artifact package as described in Creating an Artifact Type
or Package on page 33.

• File->New->Property to create a property as described in Creating a Property on page 53.

• File->New->Property Group to create a property group as described in Creating a Property Group on
page 62.

• File->New->Perspective to create a perspective as described in Creating a Perspective on page 77.

• File->New->Component to create a component as described in Creating a Component on page 81.

• File->New->Task to create a task as described in Creating a Task on page 83.

• Navigate->Go To->Open Artifact to open an artifact editor as described in Artifact Editor on page
102. The keyboard shortcut Ctrl+Alt+A also performs this function.

• Navigate->Go To->Open Property to open a property editor as described in Property Editor on page
113. The keyboard shortcut Ctrl+Alt+P also performs this function.

• Navigate->Go To->Open Property Group to open a property group editor as described in Property
Group Editor on page 117. The keyboard shortcut Ctrl+Alt+R also performs this function.

• Search->Search opens a search dialog as described in Searching the Extension on page 30.
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• Help->Dynamic Help accesses context sensitive help, directing you to the relevant section of this
document based on the active view in the Customization Editor.

Server Explorer

The Server Explorer is the bottom left pane of the Customization Editor dashboard. It lists all the servers
associated with all the Customization Editor projects, as shown in Figure 5.

Figure 5. Server Explorer View

Right-click a server in the Server Explorer to open a context menu with the options described in Table 1
on page 30.
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Table 1. Server Explorer Context Menu Options

FunctionOption

Add a server for downloading reports (for Report Editor)New Reporting Server

Add a server for downloading assertions (for Assertion Editor, Platform server
only).

New Platform Server

Delete server from Server Explorer.Remove Server

Download reports (for Report Editor, Reporting server only.Download Report

Download taxonomy (for Taxonomy Editor and Customization Editor, Platform
server only)

Download Taxonomy

Download assertions (Platform server only).Download Assertion

View and edit server name, URL, username and password (Server context menu
only).

Properties

Searching the Extension

The Customization Editor contains a customized search function that enables you to find entities in the ex-
tension project.

To search your extension project:

1 In the Search menu select Search to open the Search dialog:
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2 Complete the SDM search dialog containing parameters:

DefinitionParameter

The parameter to search the extension forContaining text

Check the box to make the search case sensitiveCase sensitive

Allows more sophisticated search parameters. For example, to find
everything with more than one word. This is an advanced topic beyond the
scope of this guide.

Regular expression

Select the SDM entities to searchSearch For

Select the entity attributes to searchSearch In

Select the extension to searchScope

3 Click Search to execute the search and view the results in the Search view (see Search View on page
136).
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Saving Modifications

As you modify an entity in your extension project the tab label of the entity editor is marked with an asterisk.

To save your changes to the project select File->Save from the File menu or use the keyboard shortcut
Ctrl+S.

If you close an editor or the application with unsaved changes you are prompted to save these changes.

These changes are made to your extension project and not to the configuration of SOA Systinet. To deploy
your modifications to SOA Systinet see Deploying an Extension to SOA Systinet on page 93.
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2 Manipulating Artifact Types

The Customization Editor can be used to create, modify and delete artifact types in your extension project.
You can also change the format of artifact pages in the SOA Systinet UI.

The chapter describes the following procedures:

• Creating an Artifact Type or Package on page 33

• Modifying the Attributes of an Artifact Type on page 37

• Modifying the Properties of an Artifact Type on page 38

• Modifying an Artifact Type in the Services UI on page 39

• Modifying an Artifact Type in the Tools UI on page 39

• Modifying the Layout of the View Artifact Page on page 40

• Modifying the Contextual Actions of an Artifact on page 43

• Mapping an Artifact Type to a Registry on page 45

• Example: Adding the Department Property to Business Services on page 49

Creating an Artifact Type or Package

This procedure describes how to create a new artifact type or package in your extension project. For more
information on artifact types and packages, see SDM Elements on page 13.

To create an artifact type:

1 To start the New Artifact Type dialog:

• In the File menu select New->Artifact Type/Package.
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• Alternatively, in the Extension Explorer right-click Artifact Types and select New Artifact
Type/Package.

• Alternatively, in the Extension Explorer right-click an artifact package branch and select New
Artifact Type/Package to create a new artifact type as part of that package.

The New Artifact Type or New Artifact Package dialog appears:

2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The name of the artifact as it is stored in the extensionLocal Name

The identifier of the artifact descriptor in the configurationURI

The plural name of the artifact as it appears in the SOA Systinet UICollection Display
Name

A browse button allows you to select the parent artifact type that this artifact
type belongs to

Package
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DefinitionParameter

A browse button allows you to select an artifact type to inherit the properties
from

Note: If you select Extends, any future changes to the chosen parent
artifact are inherited by the new artifact.

Extends

The description of the artifact type as it appears in the SOA Systinet UIDescription

3 Do one of the following:

• Click Finish to create the artifact type.

• Continue to Step 4 to set the visibility of the artifact in the SOA Systinet UI.

4 Click Next.

The New Artifact Type/Package displays visibility parameters:
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5 Complete the dialog which contains the following parameters:

DefinitionParameter

If the new artifact type extends an artifact with an existing UI configuration
check the box if you want it to inherit these attributes

Copy User Interface
configuration from par-
ent artifact type?

Check the box if the artifact type is visible in the Service UIIs the artifact available
in Service Catalog?

Use Add and Remove to select viewing permissions in the SOA Systinet
UI

Visible to

Use Add and Remove to select edit permissions in the SOA Systinet UIEditable by

6 Do one of the following:

• Click Finish to create the artifact type.

• Continue to Step 7 to set database parameters.
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7 Click Next.

The New Artifact Type/Package displays database settings.

These settings cannot be changed if the new artifact extends an artifact type that already
defines them.

Complete the dialog which contains the following parameters:

DefinitionParameter

The name of collection where the artifact instances are storedCollection name

The name of the database table where instances of this artifact are storedDatabase table
name

8 Click Finish to create the artifact type.

Modifying the Attributes of an Artifact Type

HP SOA Systinet Customization Editor enables you to edit the main attributes of artifact types.

To edit the attributes of an artifact type:

1 Open the artifact editor in the General tab.

2 The General tab displays three editable segments:

• Artifact General Information contains four editable parameters:

DefinitionParameter

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The plural version of the name as it appears in the SOA Systinet UICollection Dis-
play Name

The description of the artifact type as it appears in the SOA Systinet UIDescription
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DefinitionParameter

A checkbox indicating whether the artifact is currently active in the extensionDeprecated

• Visible to

Use Add and Remove to select the perspectives that can see this artifact type within SOA Systinet.

• Editable by

Use Add and Remove to select the perspectives that can amend this artifact type within SOA
Systinet.

Modifying the Properties of an Artifact Type

The main attributes of artifact types are properties. These can be modified, added individually, or added as
a group within the artifact editor.

To add or modify the properties and property groups of an artifact type:

1 Open the artifact editor and click the Properties tab.

2 The Properties tab contains two modifiable segments:

• Properties:

• Click New to create a new property as an attribute of the artifact type and create the property
as described in Creating a Property on page 53.

• Click Add to select a property to add to the artifact type with a selected cardinality and select
where the property appears in the Tools and Services artifact detail pages.

• Click Deprecate to deactivate the property in the artifact type.

• Click Undeprecate to reactivate a deprecated property in the artifact type.

• Select a property and click Remove to remove the property from the artifact type.
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• Property Groups:

• Click New to create a new property group as a set of attributes of the artifact type as described
in Creating a Property Group on page 62.

• Click Add to add a property group to the artifact type.

• Select a property group and click Remove to remove the group from the artifact type.

Modifying an Artifact Type in the Services UI

SOA Systinet enables you to configure the appearance of an artifact type in the view artifact page in the
Services UI.

To modify the appearance of Services UI pages:

1 Open the artifact editor and click the Service Catalog UI tab.

2 Check the Is artifact available in Service Catalog? box to make the artifact type visible in the Services
UI.

3 If the artifact type is available in the Services UI there are two elements of the view artifact page that
can be modified:

• To modify the layout of the view artifact page see Modifying the Layout of the View Artifact Page
on page 40.

• To modify the contextual actions in the view artifact page see Modifying the Contextual Actions
of an Artifact on page 43.

Modifying an Artifact Type in the Tools UI

SOA Systinet enables you to modify the appearance of an artifact type in the view artifact and browse artifact
pages of the Tools UI.
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To modify the appearance of Tools UI pages:

1 Open the artifact editor and click the Tools UI tab.

2 There are two elements of the View Artifact and Browse Artifact pages in the Tools UI that can be
modified:

• To modify the layout of the View Artifact page see Modifying the Layout of the View Artifact
Page on page 40.

• To modify contextual actions in the View Artifact page or the Browse Artifact page see Modifying
the Contextual Actions of an Artifact on page 43.

Modifying the Layout of the View Artifact Page

The View Artifact page shows the details of an artifact in both the Services and Tools tabs of SOA Systinet.
The elements that appear there can be modified with the Customization Editor.

To modify the layout of view artifact pages:

1 Open the artifact editor and click the Service Catalog UI or Tools UI tab according to which view
you want to modify.

2 In the Layout segment:

• To change the order of elements, select the element and click Up and Down.

• To remove an element select it and click Remove.

• To edit an element select it, click Edit and modify the same parameters as appear in the Add
functions.

• To add an element click Add:

• To add a new layout heading, in which to group properties and components, select Group, input
a name for the group and click Finish to add it to the layout.

• To add a property:
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Select Property and click Next to open the Layout Property Details dialog:1

2 Complete the dialog with the following parameters:

DefinitionParameter

Use Browse to select a property to be displayed in the layoutProperty

Select the layout heading for the property to be displayed under from
the drop-down list

Layout Group

Use Add and Remove to select the perspectives that can see the
property

Visible to

Use Add and Remove to select the perspectives that can edit the
property

Editable by
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3 Click Finish to add the property to the layout.

• To add a new functional UI component:

1 Select Component and click Next to open the Layout Component Details dialog:

2 Complete the dialog with the following parameters:

DefinitionParameter

Use Browse to select the componentComponent
Name

Select the layout heading that the component is part ofLayout Group
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DefinitionParameter

Use Add and Remove to select the perspectives that can see the com-
ponent

Visible to

Use Add and Remove to select the perspectives that can edit the
component

Editable by

Use Add and Remove to select parameters to use with the componentComponent
parameters

3 Click Finish to add the component to the layout.

This component must also be created using the procedure described in Creating a Task
on page 83.

Modifying the Contextual Actions of an Artifact

At the top of the View Artifact page in both Services and Tools and the Browse Artifact page in Tools
is a section containing sets of Contextual Actions. The actions that appear there can be modified with the
Customization Editor.

To modify the contextual actions in view and browse artifact pages:

1 Open the artifact editor and click the Service Catalog UI or Tools UI tab according to which view
you want to modify.

2 In the Contextual Actions segment:

In the Tools UI tab this segment contains two tabs:

• Artifact Detail refers to the View Artifact page.

• Collection refers to the Browse Artifact page.
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• To change the order of actions, select the action and click Up and Down.

• To remove an action select it and click Remove.

• To edit an action element select it, click Edit and modify the same parameters as appear in the
Add functions.

• To add an action element click Add:

• To add a contextual menu heading select UI Group, input a display name for the group and
click Finish to add it to the context menu.

• To add a contextual action item:

1 Select Contextual action item and click Next to open the Contextual Action Item Details
dialog:

2 Complete the dialog which contains the following parameters:
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DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

The description of the context actionDescription

Select the action from the listAction

Select the action menu that the action is part ofUI Group

Use Add and Remove to select the perspectives that can see the
property

Visible to

3 Click Finish to add the element to the context action menu.

• To add a set of contextual actions to the menu:

1 Select Contextual action group reference and click Next to open the Group reference
detail dialog.

2 Select the Contextual action group for the required set of actions and the UI group that
the actions appears in and click Finish to add the set of actions to the contextual menus.

Mapping an Artifact Type to a Registry

Artifacts in SOA Systinet can be mapped to registry entities in a UDDI registry.

The following artifact types have predefined mappings to registry and cannot be amended:
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Table 2. Predefined Registry Mapping

DirectionUDDI entitySDM artifact

Bi-directionalBusinessEntityOrganizational Unit

Bi-directionaltModelBusiness Service

Bi-directionalBusiness ServiceImplementation Artifacts

Bi-directionalBindingTemplateEndpoint

Figure 6 illustrates the mapping of an artifact to a registry entity:

Figure 6. Registry Mapping

To add or modify artifact type mappings to registry entities:

1 Open the artifact editor and click the Registry Mapping tab.

2 The functionality of the Artifact Mapping segment and Property Mapping is the same:

• To edit a mapping, select the mapping, click Edit and modify the same parameters as appear in
the Add functionality.
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• To remove a mapping select the mapping and click Remove.

• To add a registry mapping for an artifact type:

1 In the Artifact Mapping segment click Add to open the New Artifact Mapping dialog:

2 Complete the dialog with the following parameters:

DefinitionParameter

Use Select to select from the available registriesRegistry

Use Add to select from the available taxonomies or input oneT-ModelKey

If you are mapping to a UDDI version 2 registry input a taxonomy keyT-ModelKey
version 2

The name used to categorize the UDDI entity in the registryKey Name

The value used to categorize the tModel in the registryKey Value
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DefinitionParameter

The name of the mapping as it appears in the SOA Systinet UIDisplay Name

If selected, the content of documents referenced from the UDDI entity
are cached in SOA Systinet

Cache content

Select the direction of the mapping from the drop-down listDirection

3 Click Finish to add the mapping.

• To add a registry mapping for a property:

1 In the Property Mapping segment click Add to open the New Property Mapping dialog:

2 Complete the dialog with the following parameters:

DefinitionParameter

Use Select to select from the available propertiesProperty
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DefinitionParameter

Select the direction of the mapping from the drop-down listDirection

Use Select to select from the available registriesRegistry

Use Add to select from the available taxonomies or input oneT-ModelKey

If you are mapping to a UDDI version 2 registry input a taxonomy keyT-ModelKey
version 2

The name used to categorize the UDDI entity in the registryKey Name

3 Click Finish to add the mapping.

Example: Adding the Department Property to Business Services

In this example, you add a new taxonomic property, department, to the business service artifact, and make
it visible in the service view of a business service.

Figure 7. Default Service View of a Business Service
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To follow this example requires the following prerequisites:

• Create a new extension dependent on the core extension, as described in Creating an Extension Project
on page 17.

• Create the new department taxonomy and deploy it to SOA Systinet, as described in the Example:
Creating and Publishing a Department Taxonomy section of the HP SOA Systinet Taxonomy Editor
Guide.

To add the department property to business services:

1 Open the business service editor and navigate to the Properties tab.

2 Click New to add a new property as described in Modifying the Properties of an Artifact Type on page
38.

3 Select Taxonomy Property and click Next.

4 Input Department as the Display Name.

5 For the Taxonomy, click Browse and import the Departments taxonomy.

6 Click Next to set the visibility of the department property.

7 For the Service Catalog UI group, select Service Properties, and then click Finish.

8 Press Ctrl+S to save your changes to the business service artifact type.

9 Deploy your extension, as described in Deploying an Extension to SOA Systinet on page 93.

10 Start your installation of SOA Systinet.

After you deploy this customization, the service properties section of the service view of a business service
includes the new department property.

Chapter 250



Figure 8. Customized Service View of a Business Service

This property can now be set during business service creation.
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3 Manipulating Properties

The Customization Editor enables you to create, modify and delete properties and property groups in your
extension project.

The property procedures are:

• Creating a Property on page 53 describes how to create properties of types:

• Primitive

• Relationship

• Taxonomy

• Modifying a Property on page 59

• Creating a Property Group on page 62

• Modifying a Property Group on page 63

Manipulating Artifact Types on page 33 includes these procedures which are also related to properties:

• Modifying the Properties of an Artifact Type on page 38 describes how to add properties to an artifact.

• Mapping an Artifact Type to a Registry on page 45 describes how to add registry mappings to an artifact
and its properties.

Creating a Property

This procedure describes how to create a new property descriptor in your extension project. For more in-
formation on properties, see SDM Elements on page 13.
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To create a property:

1 Do one of the following:

• In the File menu select New->Property.

• Alternatively, in the Extension Explorer right-click Property Descriptors and select New
Property and the property type.

• Alternatively, in the Extension Explorer right-click a property type branch and select New Type
Property to create a property of that type.

The New Property dialog appears.

2 A different dialog opens depending on the property type:

• For primitive properties:

Complete the dialog which contains the following parameters:
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DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for property in the configurationURI

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

Use Browse to select a property from the available primitive property
types

Property Type

• For relationship properties which are created in pairs:
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Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the property in the configurationURI
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DefinitionParameter

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

Select a type from the drop-down listRelation Type

Use Browse to select the source artifact type of the relationshipFrom Artifact

Use Browse to select the target artifact type of the relationshipTo Artifact

The name of the inverse relationship property as it appears in the SOA
Systinet UI

Inverse Display Name

The name of the inverse relationship property as it is stored in the exten-
sion

Inverse Local Name

The identifier for the inverse property descriptor in the configurationInverse URI

The plural name of the inverse relationship property as it appears in the
SOA Systinet UI

Inverse Collection Dis-
play Name

The description of the inverse relationship property as it appears in the
SOA Systinet UI

Inverse Relationship
Description

• For taxonomy properties:
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Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the property in the configurationURI

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

Use Browse to select a taxonomy from the available taxonomies with
an option to import taxonomies available in SOA Systinet that are not
in your extension.

Taxonomy

3 Do one of the following:
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Click Finish to create the property.•

• Continue to Step 4 to set property visibility.

4 Click Next.

The New Property dialog displays visibility parameters:

5 Complete the dialog which contains the following parameters:

DefinitionParameter

Use Add and Remove to select viewing permissions in the SOA Systinet UIVisible to

Use Add and Remove to select edit permissions in the SOA Systinet UIEditable by

6 Click Finish to create the new property.

Modifying a Property

HP SOA Systinet Customization Editor enables you to modify properties.

59Manipulating Properties



To edit a property:

1 Open the property editor.

2 Edit the general attributes of the property in the General tab and the advanced attributes in the Advanced
tab.

• The General tab contains the following editable segments:

• General contains the following editable parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The description of the property as it appears in the SOA Systinet UIDescription

The plural version of the name as it appears in the SOA Systinet UICollection
Display Name

A checkbox indicating whether the property is currently active in the extensionDeprecated

• There are three types of property and the second segment is specific to each:

• Property Type

Primitive properties are not editable and just display the property type.

• Relationship

Use Add and Remove to select the endpoints of the relationship.

• Taxonomy

Use Browse to select a new taxonomy from the extension project.

• Visible to

Use Add and Remove to select the perspectives that can see this property within SOA Systinet.
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• Editable by

Use Add and Remove to select the perspectives that can amend this property within SOA
Systinet.

• The Advanced tab contains the following editable segments:

• Multiple Cardinality contains the following editable parameters:

DefinitionParameter

For multiple cardinality enter a minimum number of instances of the propertyMinOccurs

For multiple cardinality enter a maximum number of instances of the property.
Use unbounded if there is no limit.

MaxOccurs

Important: Properties that inherit urn:com:systinet:soa:model:propertyTypes:text, such
as Name, cannot have multiple instances. If you need a text property with multiple
cardinality, use one that inherits urn:com:systinet:soa:model:propertyTypes:plainText.

• Default Values contains the following editable parameters:

DefinitionParameter

Default value is described by an XML element which must follow the rules
defined by XML schema for the selected property and property type. For
example, a primitive plain text property with local name email is defined
by

<p:email xmlns:p="http://systinet.com/2005/05/soa/model/prop-
erty">value</p:email>

Default Value
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DefinitionParameter

If the property has multiple cardinality then specify more than one default
value. For example, a plain text property with local name email and multiple
cardinality is defined by

<g:emailGroup
    xmlns:g="http://systinet.com/2005/05/soa/model/propertyGroup"
    xmlns:p="http://systinet.com/2005/05/soa/model/property">
  <p:email>value1</p:email>
  <p:email>value2</p:email> 
  </g:emailGroup>

Important: Properties that inherit urn:com:systinet:soa:model:prop-
ertyTypes:text, such as Name, cannot have multiple instances. If
you need a text property with multiple cardinality, use one that
inherits urn:com:systinet:soa:model:propertyTypes:plainText.

Multiple Default
Value

• Database Sizes enables you to optionally set the storage size of property elements with Add,
Edit and Remove functionality.

Creating a Property Group

As many artifacts share sets of the same properties it is useful to create groups of properties and add these
to the artifacts instead.

To create a property group:

1 Do one of the following:

• In the File menu select New->Property Group.

• Alternatively, in the Extension Explorer right-click Property Groups and select New Property
Group.
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• Alternatively, in the artifact Properties tab click New in the Property Groups segment to create
a new group as a set of attributes for an artifact type.

The New Property Group dialog appears:

2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property group as it appears in the SOA Systinet UIDisplay Name

The identifier for the property group descriptor in the configurationURI

Use Add and Remove to select the properties in the groupProperties

3 Click Finish to create the property group.

Modifying a Property Group

HP SOA Systinet Customization Editor enables you to modify property groups.
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To edit a property group:

1 Open the property group editor.

2 Modify the property group with one of the following functions:

• Edit the General segment to change the display name of the property group.

• Click New under Properties to create a new property as part of the group as described in Creating
a Property on page 53.

• Click Add to add a property to the group from the list of available properties.

• Click Remove to remove a property from the group.
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4 Configuring the SOA Systinet UI

The main tabs in SOA Systinet can be modified and also the appearance of artifact pages can be altered
using the Customization Editor

The procedures for altering the appearance of artifact pages are in Manipulating Artifact Types on page 33.
This section deals with creating and modifying UI elements and modifying the appearance of the main SOA
Systinet tabs.

The available procedures are:

• Adding Portlets to a SOA Systinet Tab on page 66. 

• Adding Navigation Groups to a SOA Systinet Tab on page 67. 

• Adding Navigation Actions to an SOA Systinet Tab on page 68. 

• Adding Components to a SOA Systinet Tab on page 69. 

• Creating a Navigation Action on page 70. 

• Creating a Contextual Action on page 73. 

• Creating a Context Action Group on page 75. 

• Adding Context Actions to a Group on page 75. 

• Creating a Portlet on page 78. 

• Creating an RSS Feed Portlet on page 78. 

• Creating a Perspective on page 77. 
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Adding Portlets to a SOA Systinet Tab

The Customization Editor can be used to configure the portlets that are available in each tab in SOA Systinet
and where they appear on the tab.

To add portlet to a SOA Systinet tab:

1 Open the Portlets editor for the SOA Systinet tab you want to modify.

2 Click Add to open the New Portlet Placement dialog:

3 Complete the dialog which contains the following parameters:

DefinitionParameter

Click Browse to select from the available portletsPortlet Reference

The name of the portlet as it appears in the SOA Systinet UIDisplay Name
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DefinitionParameter

There are two options:

• Page. The portlet is open in the main area of the SOA Systinet tab

• Menu. The portlet is closed but available to add in the left menu

Location

If the portlet is located on the page then use the drop-down list to select which
column it appears in

Column

Type a number into this field if this portlet occupies the same column as another
portlet. The number defines the order of portlets in the column. The portlet with
the lowest order is first (towards the top).

Order

If Menu is selected check this box to enable multiple instances of the portlet.Permanent

Use Add and Remove to select the perspectives that can see the portletVisible to

4 Click Finish add the portlet to the SOA Systinet tab.

Adding Navigation Groups to a SOA Systinet Tab

The Customization Editor can be used to configure the menu in each SOA Systinet tab. The items in the
menu are organized into sections.

To add a navigation group to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type dialog.

3 Select Group and click Next to open the Group Details dialog.

4 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the group heading as it appears in the SOA Systinet UIGroup Name
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DefinitionParameter

A description of the new navigation groupDescription

Use Add and Remove to select viewing permissions in the SOA Systinet UIVisible to

5 Click Finish add the group to the SOA Systinet tab menu.

Adding Navigation Actions to an SOA Systinet Tab

The Customization Editor can be used to configure the menu in each SOA Systinet tab. Each item in the
menu corresponds to a navigation action linking to another page in SOA Systinet.

To add a navigation item to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add. The Choose Type dialog opens.

3 Select Item and click Next. The Menu Item dialog opens.
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4 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the navigation link as it appears in the SOA Systinet UI.Item Name

Browse for the Navigation Action ID.Action ID

Select the menu heading that the item is part of from the drop-down list.Group Name

A description of the new navigation item.Description

Use Add and Remove to select the perpectives that can see the itemVisible to

5 Click Finish add the item to the SOA Systinet tab menu.

Adding Components to a SOA Systinet Tab

The Customization Editor can be used to configure the left-menu in each tab in SOA Systinet. Some items
in the menu are links to a component that performs specific functionality.

To add a component to a SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type dialog.

3 Select Component and click Next to open the Component Details dialog:
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4 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the componentComponent Action

Select the menu heading that the component is part of from the drop-down listGroup Name

Use Add and Remove to select the perspectives that can see the componentVisible to

Use Add and Remove to select parameters to use with the componentComponent para-
meters

5 Click Finish add the component to the SOA Systinet tab menu.

Creating a Navigation Action

Navigation actions are links from the tab menus to pages in SOA Systinet.
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To create an action:

1 Do one of the following:

• In the Extension Explorer, go to User Interface–>UI Details–>Navigation Actions. Right-click
Navigation Actions and select New Navigation Action in the context menu.

• Alternatively, click New in the Navigation Actions editor.

The New Action dialog appears:

2 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the contextual or navigation actionAction ID

The name of the action that for is called when the user clicks the link.Task Location
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DefinitionParameter

Use Add and Remove to select the task parameters for the navigation or contex-
tual action specified in Task Location. The task parameters are:

• Key. The name of the parameter

• Value. The value of the parameter

Task Parameters

The name of the SSO partnerPartner

A relative URL pointing to the resource, that is accessed via SSOPartner Path

3 Click Finish to create the new action.

The full URL is compiled from the base URL retrieved from the DB (where the key is the name
of the SSO Partner) and the relative URL.

If SSO is not needed to render the menu item, then only the task location and task parameters are used. If
SSO is required (the menu item references a task/resource in a different product than it is rendered in) then
the target URL is composed from partner, partner path and task parameters.

For example:

    <action id="tools.newOther">
      <partner>@platform.sso.identity.id</partner>
      <partnerPath>web/publishing/structuredFile/wizard</partnerPath>
      <task location="/publishing/structuredFile/wizard">
        <parameter key="FirstUIStateID">fileDetails</parameter>
      </task>
    </action>

The SSO URL is composed from e.g. http://johngalt:8080/soa/systinet/platform/ + web/publishing/struc-
turedFile/wizard + ? + FirstUIStateID=fileDetails to final form http://johngalt:8080/soa/systinet/plat-
form/web/publishing/structuredFile/wizard?FirstUIStateID=fileDetails
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Creating a Contextual Action

Contextual actions are links from the context menus in artifact detail and browse pages.

To create an action:

1 Do one of the following:

• Right-click the Contextual Actions branch in the Extension Explorer and select New Contextual
Action.

• Alternatively, click New in the Contextual Actions editor.

The New Action dialog appears:

2 Complete the dialog which contains the following parameters:
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DefinitionParameter

The identification of the contextual or navigation actionAction ID

De-select if you want to use a specific component instead of a taskUse predefined
link renderer

Use Browse to select the task called by the new context action.Target Task

If Use predefined link renderer is not selected use Browse to select the com-
ponent

Component name

Use Add and Remove to select the task parameters for the navigation or contex-
tual action specified in Task Location which consist of:

• Key. The name of the parameter

• Value. The value of the parameter

Task Parameters

The name of the SSO partnerPartner

A relative URL pointing to the resource, that is accessed via SSOPartner Path

3 Click Finish to create the new action.

The full URL is compiled from the base URL retrieved from the DB (where the key is the name
of the SSO Partner) and the relative URL.

If SSO is not needed to render the contextual item, then only the task location and task parameters are used.
If SSO is required (the contextual item references a task/resource in a different product than it is rendered
in) then the target URL is composed from partner, partner path and task parameters.

For example:

    <action id="tools.newOther">
      <partner>@platform.sso.identity.id</partner>
      <partnerPath>web/publishing/structuredFile/wizard</partnerPath>
      <task location="/publishing/structuredFile/wizard">
        <parameter key="FirstUIStateID">fileDetails</parameter>
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      </task>
    </action>

The SSO URL is composed from e.g. http://johngalt:8080/soa/systinet/platform/ + web/publishing/struc-
turedFile/wizard + ? + FirstUIStateID=fileDetails to final form http://johngalt:8080/soa/systinet/plat-
form/web/publishing/structuredFile/wizard?FirstUIStateID=fileDetails

Creating a Context Action Group

As many artifact types share sets of the context actions it is useful to make groups of actions and add these
to artifact types instead.

To create a context action group:

1 Do one of the following:

• In the Extension Explorer right-click the Contextual Action Groups branch and select New
Context Action Group.

• Alternatively, click Add in the Contextual Action Groups editor.

The Contextual Actions dialog appears.

2 Select Group of Contextual Actions and click Next.

3 Input the display name for the group and click Finish to create the contextual action group.

Adding Context Actions to a Group

As many artifact types share sets of the context actions it is useful to make groups of actions and add these
to artifact types instead.

To add a context action to a group:

1 • In the Extension Explorer right-click User Interface–>UI Details–>Contextual Action Groups.
Select New Context Action Group from the context menu.

• Alternatively, click New in the Contextual Action Groups editor.
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The Contextual Actions dialog appears.

2 Select Action Item and click Next. The New Contextual Action Item dialog opens.

3 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the context action item.Display Name

A description of the item.Description

Browse for the action to add.Action

From the drop-down list, select the group to which you want to add the action.Group

Use Add and Remove to select the perspectives that can see the action.Visible to

4 Click Finish add the action to the group.
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Creating a Perspective

Perspectives control the views of SOA Systinet that are available to each user.

To create a perspective:

1 Do one of the following:

• In the Extension Explorer right-click the Perspectives branch and select New Perspective.

• Alternatively, click New in the Perspectives editor.

The New Perspective dialog appears:

2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the perspective in the extension projectPerspective ID

The name of the perspective as it appears in the SOA Systinet UIDisplay Name

The description of the perspective as it appears in the UIDescription

3 Click Finish to create the perspective.
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Creating a Portlet

Portlets are the components in the main section of SOA Systinet tabs with varying functionality depending
on the portlet.

To create a portlet:

1 In the Extension Explorer double-click the Portlets Definitions branch to open the Portlets Definitions
editor.

2 Click Add and select Portlet to open the Add Portlet dialog.

3 Input a name and url for the portlet and click Finish to create the portlet.

Creating an RSS Feed Portlet

The RSS feed portlets in the main section of SOA Systinet tabs display up-to-date views of repository data
or links to external RSS feeds.

To create an RSS Feed Portlet:

1 In the Extension Explorer double-click the Portlets Definitions branch to open the Portlets Definitions
editor.

2 Click New and select Feed to open the Add Feed dialog:

Chapter 478



3 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the portlet definitionPortlet ID

The link to the RSS sourceUrl

The name of the SSO partnerPartner

Check the box to allow multiple instances of the feedMultiple Instances

4 Click Finish to create the feed.
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5 Creating and Using Components

HP SOA Systinet Customization Editor enables you to create custom components, deploy them to the SOA
Systinet UI directly from the Customization Editor, and to debug your code.

The complete process is:

1 Create a new extension project, as described in Creating an Extension Project on page 17, selecting
Develop JSPs, and setting the appropriate application server settings.

2 Create a component, as described in Creating a Component on page 81.

3 Create a task to use your component, as described in Creating a Task on page 83.

4 Create a navigation action to use your task, as described in Creating a Navigation Action on page 70.

5 Add the navigation item to the UI, as described in Adding Navigation Actions to an SOA Systinet Tab
on page 68.

6 Develop the Java and JSP that the component uses in Customization Editor, as described in Developing
the Component on page 84.

7 Deploy the extension directly from Customization Editor, as described in Direct Deployment to SOA
Systinet on page 98.

8 Debug your code in Customization Editor, as described in Debugging Your Code on page 85.

Example: Adding a Component to the Tools Menu on page 86 is a step-by-step walkthrough of this process.

Creating a Component

Components are functional elements which can called by a number of different elements in the SOA Sys-
tinet UI.
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To create a component:

1 Do one of the following:

• In the Extension Explorer right-click the Components branch and select New Component.

• Alternatively, click Add in the Components editor.

The New Component dialog appears:

2 Input the following parameters:

DefinitionParameter

The name of the component as it is stored in the extensionName

The JSP used by the component.Page

The Java class used by the component.Class name

Use Add and Remove to select parameters to use with the componentComponent
parameters
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3 Click Finish to create the component.

Creating a Task

Tasks are top level components accessible via their uris. The addition of a uri allows you to access the
component in the SOA Systinet UI and make more sophisticated multi-layered components.

To create a task:

1 Do one of the following:

• In the Extension Explorer right-click the Tasks branch and select New Task.

• Alternatively, click Add in the Tasks editor.

The New Task dialog appears:

2 Input the following parameters:
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DefinitionParameter

The identifier for the taskUri

Use Browse to select the component to associate with the taskComponent

A name for the taskCaption

Use Browse to select the SOA Systinet context associated with the task. Context
specifies, for example, the content of the left menu.

Context

Use Add and Remove to select parameters to use with the taskTask paramet-
ers

Select Wrap to contain the task output in the SOA Systinet UIWrap

Select Requires Authentication if the task requires the user to log in before execu-
tion

Requires Au-
thentication

3 Click Finish to create the task.

Developing the Component

When you create a component, as described in Creating a Component on page 81, the templates for the
Java class and JSP page are automatically created.

To view this code you must switch to the Java or the Debug perspective:
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Figure 9. Debug Perspective

The project contains two source folders containing the Java and JSP files respectively.

Double-click the source file you want to edit to open an edit view enabling you to write your custom com-
ponent.

Debugging Your Code

Only changes to the UI or the SDM configuration require the extension to be deployed to SOA Systinet.
After you deploy a navigation action that uses your custom component, you can edit your Java and JSP and
the new functionality is applied to SOA Systinet directly.
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To start SOA Systinet from Customization Editor:

1 In the Run menu, select Debug to open the Debug dialog.

2 Select your server deployment under Generic Servers, and then click Debug to start the server in debug
mode.

The Console view displays the progress of the server start.

When the server is started the Server view displays your server with status Debugging.

Make changes to your Java and JSP as required and these changes are applied to SOA Systinet without the
need to reapply the extension of restart the server.

Example: Adding a Component to the Tools Menu

In this example, you add a new component, to Tools menu in the SOA Systinet UI.

Figure 10. Default Tools Menu View Section

To follow this example requires the following prerequisites:

• Create a new extension dependent on the core extension with Develop JSPs selected, as described in
Creating an Extension Project on page 17.
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To create the new component and add it to the tools menu:

1 Create a component as described in Creating a Component on page 81 using the following inputs:

InputParameter

testComponentName

/test/testComponent.jspPage

test.TestComponentClass name

2 Create a task as described in Creating a Task on page 83 using the following inputs:

InputParameter

/test/testUriUri

testComponentComponent

testTaskCaption

/index/repositoryContext

SelectedWrap

Select if you want the user to sign-in to use the componentRequires Authentication

3 Create a navigation action as described in Creating a Navigation Action on page 70 using the following
inputs:

InputParameter

testNavActionAction ID

/test/testUriTask Location

4 Add the navigation action to the Tools tab as described in Adding Navigation Actions to an SOA
Systinet Tab on page 68. Select Item and use the following inputs:
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InputParameter

testNavItemItem Name

testNavActionAction ID

ViewGroup Name

5 Create your Java class and JSP as described in Developing the Component on page 84 adding the fol-
lowing code:

InputEditor

public void process(String arg0, Map arg1) { getRequest().setAt-
tribute("test", "created and deployed your test component."); }

TestComponent.java

You have succesfully <c:out value="${test}"/>testComponent.jsp

6 Apply the extension as described in Direct Deployment to SOA Systinet on page 98.

7 Start the SOA Systinet server as described in Debugging Your Code on page 85.

After you deploy this customization, the View section Tools menu includes the new navigation action.

Figure 11. Customized Tools Menu View Section
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Click testNavItem to execute the task.
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6 Modifying Taxonomies

The Customization Editor controls which taxonomies are available in the extension project. You can create
and modify taxonomies using HP SOA Systinet Taxonomy Editor.

To control taxonomies in your extension project:

1 In the Extension Explorer double-click Taxonomies to open the Taxonomies editor.

2 To modify the available taxonomies in your extension project:

• To import taxonomies from SOA Systinet and add them to the extension click Import. You can
also import taxonomies from a server context menu (see Server Explorer on page 29).

• To update taxonomies in your extension newer versions from SOA Systinet click Update.

• To remove a taxonomy from the extension, select the taxonomy and click Remove.

To enable the import or update of taxonomies from SOA Systinet you must specify the correct
server URL during configuration (see Creating an Extension Project on page 17).
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7 Deploying an Extension to SOA Systin-
et

Deploying an extension to SOA Systinet is a three-part process:

1 Save your new extension project as a jar file in the SOA Systinet extension folder as described in Ex-
porting the Extension Project on page 93.

2 Deploy the extension to SOA Systinet using the Setup Tool as described in Applying Extensions on
page 94.

3 Redeploy the EAR file to your application server as described in Redeploying the EAR to JBoss on
page 97.

Alternatively, if you are developing components in Customization Editor, you can directly deploy the ex-
tension from Customization Editor as described in Direct Deployment to SOA Systinet on page 98.

Exporting the Extension Project

Customization Editor displays the entire configuration of your extension plus other extensions it depends
on. However, your extension only consists of any modifications and additions that you have made. Only
these changes are stored when you save your project as an extension jar file and only these changes are
deployed to SOA Systinet

To create your extension package:

1 Right-click the extension name in the Extension Explorer (see Navigating the Customization Editor
on page 22 and select Build Extension to open the export dialog.

2 By default, the Extension Folder set during configuration (see Creating an Extension Project on page
17) is selected. Choose a save location and file name and click Save.
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Applying Extensions

SOA Systinet can be extended with libraries that are added into the deployed EAR files. The setup tool
opens the EAR files, applies the extensions, and then repacks the EAR files.

Extensions to SOA Systinet come from the following sources:

• The HP SOA Systinet Customization Editor

• HP SOA Systinet Policy Manager extensions used to create assertions in HP SOA Systinet Assertion
Editor. These extensions are custom validation handlers. You must apply them to the Policy Manager
server in order for Policy Manager to use assertions created with them.

• Upgrading from the Visibility Edition to the Standard Edition, which requires Policy Manager and
Contract Manager extensions to be added to SOA Systinet.

Apply extensions according to one of the following scenarios:

• Single-Step Scenario on page 94 – In this scenario, the setup tool performs all the processes involved
in applying extensions, including database alterations, as a single, seamless step.

• Decoupled DB Scenario on page 95 – In this scenario, database SQL scripts are run manually, and the
setup tool performs the other processes as individual steps that are executable on demand. This is useful
in organizations where the user who applies extensions does not have the right to alter the database,
which is done by a database administrator.

Single-Step Scenario

Follow this scenario if you have permission to alter the database used for SOA Systinet.

To apply extensions to SOA Systinet in a single step:

1 Ensure that all extensions are in the PLATFORM_HOME/extensions  directory. The setup tool automatically
applies all extensions in that directory.

Note: If you are applying extensions to another server, substitute PLATFORM_HOME with the relevant
home directory.
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2 Stop the server.

3 Start the setup tool by executing PLATFORM_HOME/bin/setup.bat(sh).

Important: The application server to which SOA Systinet is deployed must not be running.

4 Select the Apply Extensions scenario and click Next. The setup tool automatically validates the step
by connecting to the server, copying the extensions and merging the SDM configuration.

5 Click Next for each of the validation steps and the setup execution. Note that this takes some time.

6 Click Finish to end the process.

7 For JBoss implementations the EAR file is deployed automatically. For WebLogic, WebSphere and
Oracle Application Server, redeploy the EAR file as described in:

• For WebLogic, follow the procedure described in the Deploying SOA Systinet Components section
of the HP SOA Systinet Installation Guide.

• For WebSphere, follow the procedure described in the Deploying the SSO Service and Creating
EAR Files section of the HP SOA Systinet Installation Guide.

• For OAS, follow the procedure described in the Creating and Deploying SOA Systinet EARs section
of the HP SOA Systinet Installation Guide.

8 Restart the server.

Decoupled DB Scenario

Follow this scenario if the user who applies extensions does not also modify the database.

To apply extensions and modify the database separately:

1 Ensure that all extensions are in the PLATFORM_HOME/extensions  directory. The setup tool automatically
applies all extensions in that directory.
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Note: If you are applying extensions to another server, substitute PLATFORM_HOME with the relevant
home directory.

2 Stop the server.

3 Start the setup tool by executing PLATFORM_HOME/bin/setup.bat(sh).

Important: The application server to which SOA Systinet is deployed must not be running.

4 Select the Advanced scenario and click Next.

5 Scroll down and select the following options:

• Extensions environment setup

• Extensions model execution

• Extensions database prepare

• Extensions database backup

6 Click Next, execute the chosen steps, and exit the setup tool.

7 The database administrator runs the following SQL scripts. INSTALL_HOME refers to the installation
directory of the SOA Systinet component to which you are applying the extensions. The SQL scripts
must be run in this order:

a INSTALL_HOME\conf\sql\dbschema_YOUR-DATABASE_drop.sql

b INSTALL_HOME\working\sdm-gen\build\rdbms\sql\dbschema_YOUR-DATABASE_create.sql

Note: For DB2, the token &1 must be replaced by the tablespace name.
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c INSTALL_HOME\working\sdm-gen\build\rdbms\sql\dbschema_YOUR-DATABASE_insert.sql

8 Start the setup tool by executing PLATFORM_HOME/bin/setup.bat(sh).

Important: The application server to which SOA Systinet is deployed must not be running.

9 Select the Advanced scenario and click Next.

10 Select the following options:

• Extensions database SQL sync

• Extensions database restore

• Extensions nonmodel execution

• Extensions environment finalize

• Client package creation

11 Click Next, execute the chosen steps, and exit the setup tool.

12 For WebLogic and WebSphere, deploy the new EAR file in the INSTALL_HOME\deploy directory.

Redeploying the EAR to JBoss

After using the setup tool to apply extensions or updates it is necessary to redeploy the EAR file to the ap-
plication server. For JBoss this can be done using the setup tool.

For other application servers, follow the EAR deployment procedures described in the relevant
sections of Deploying SOA Systinet to Application Servers in the HP SOA Systinet Installation
Guide.
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To redeploy the EAR to JBoss:

1 Stop the application server.

2 Start the setup tool by executing PLATFORM_HOME/bin/setup.bat(sh).

Important: The application server to which SOA Systinet is deployed must not be running.

3 Choose the Advanced scenario and click Next.

4 Scroll down, select Deployment, and then click Next.

5 When the setup tool validates the existence of the JBoss Deployment folder, click Next.

6 Click Finish to close the setup tool.

7 Restart the application server.

Direct Deployment to SOA Systinet

If you are creating components in Customization Editor it is not convenient to continually build and apply
extensions to SOA Systinet. Customization Editor enables you to deploy your extension directly to SOA
Systinet.

Only SOA Systinet deployed to a JBoss application server is supported by this release.

To directly deploy an extension from Customization Editor:

1 Stop the application server.

2 Switch to the Debug perspective in Customization Editor.

3 Select Run->External Tools->Open External Tools Dialog from the menu to open the External
Tools dialog.
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4 Select Ant Build->Customization Editor - Apply Extension.

5 Click Run to apply the extension.

The Console view displays the output of the deployment process.
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8 User Interface Reference

Each Customization Editor view in the main and bottom-right section of the editor is described in the fol-
lowing sections:

• Artifact Editor on page 102. Manage your SOA artifacts and customize their properties, appearance and
registry mapping.

• Property Editor on page 113. Manage your SOA properties and which perspectives can see and edit them.

• Property Group Editor on page 117. Organize your properties into groups.

• Navigation Editor on page 118. Customize the left-menu navigation links in SOA Systinet tabs.

• Portlets Editor on page 120. Customize which portlets appear in SOA Systinet tabs.

• Components Editor on page 122. Manage the components in SOA Systinet.

• Contextual Action Groups Editor on page 123. Organize your context actions into groups.

• Contextual Actions Editor on page 124. Manage the context actions available in the SOA Systinet UI.

• Navigation Actions Editor on page 126. Manage the navigation links available in SOA Systinet.

• Portlets Definitions Editor on page 128. Manage the portlets available in SOA Systinet.

• Tasks Editor on page 129. Manage tasks in SOA Systinet.

• Perspectives Editor on page 127. Customize the perspectives available in SOA Systinet.

• Taxonomies Editor on page 131. Customize the taxonomies available in SOA Systinet.

• project.xml Editor on page 132. Manage your extension project.

• Messages View on page 135. View the action log as you customize your extension project.
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• Search View on page 136. View the results of usage and entity searches.

Artifact Editor

Artifacts are the basic building blocks of SOA and represent all types of entity. This editor allows you to
modify the parameters, properties and appearance of an artifact type within SOA Systinet. Each artifact
type and package has an editor with the artifact name as the title containing five tabs described in the fol-
lowing sections:

• Artifact – General Tab on page 102 . The main attributes of the artifact type

• Artifact – Properties Tab on page 104 . The properties of the artifact type

• Artifact – Service Catalog UI Tab on page 106 . The format of the View Artifact page in the SOA
Systinet UI

• Artifact – Tools UI Tab on page 109 . The format of the View Artifact and Browse Artifact pages in
the SOA Systinet UI

• Artifact – Registry Mapping Tab on page 111 . The mapping of the artifact to registry entities

Artifact – General Tab

The General tab displays the general attributes of the artifact and allows you to modify some of them:
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Figure 12. Business Service Editor – General Tab

The general tab contains the following segments:

• Artifact General Information. The following parameters related to artifacts shown in this segment.
They are described in the table below:

DefinitionParameter

The identifier for the artifact descriptor in the configurationURI

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The name of the artifact as it is stored in the extensionLocal Name

The plural version of the name as it appears in the SOA Systinet UICollection Display
Name
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DefinitionParameter

The parent artifact type that this artifact type belongs toPackage

The artifact type that this artifact type inherits the properties ofExtends Type

The description of the artifact type as it appears in the SOA Systinet UIDescription

A checkbox indicating whether the artifact is currently active in the extensionDeprecated

A checkbox indicating whether the artifact is an artifact package which does not
have actual instances in the repository

Abstract

• Visible to. A simple list of perspectives with Add and Remove functionality to select which perspectives
can see this artifact type within SOA Systinet.

• Editable by. A simple list of perspectives with Add and Remove functionality to select which perspect-
ives can amend this artifact type within SOA Systinet.

• Properties. A summary of the different properties that the artifact has. Each of the links opens the
Properties tab described in Artifact – Properties Tab on page 104.

• User Interface. A pair of links to the Service Catalog UI and Tools UI tabs where the appearance of
the artifact in the SOA Systinet UI can be amended.

Artifact – Properties Tab

The Properties tab displays all the properties of the artifact and enables you to add and remove them:
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Figure 13. Business Service Editor – Properties Tab

This tab contains the following segments:

• Properties. This is the list of individual properties of the artifact. On the right are the following buttons:

• New opens the New Property dialog described in Creating a Property on page 53.

• Add adds a property to the artifact type from the list of available property descriptors, set its cardin-
ality, and its location on the View Artifact page.

• Deprecate deactivates the property in the artifact type.

• Undeprecate reactivates the property in the artifact type.

• Remove removes the selected property from the artifact type.
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• Property Groups. This is the list of the property groups of the artifact. On the right are the following
buttons:

• New opens the New Property Group dialog described in Creating a Property Group on page 62

• Add adds a property group to the artifact type from the list of available property groups.

• Remove removes the selected property group from the artifact type.

• Inherited Groups and Properties. If the artifact is based on another artifact then this segment displays
the inherited artifact and its properties and groups.

The following property parameters are displayed in these segments:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIName

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Which extension this property is part ofExtension

Artifact – Service Catalog UI Tab

The Service Catalog UI tab displays all the attributes of the artifact as they appear in the Service View
page of the Service Catalog in SOA Systinet and allows them to be amended:
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Figure 14. Business Service Editor – Service Catalog UI Tab

There is a checkbox to control whether the artifact is available within the Service Catalog and if this is
checked there are two segments to control its appearance:

• Layout. This is the list of elements and properties of the artifact as they appear in the Service View
page in the Service Catalog. The elements are organized into groups that match the sub-headings on the
Service View page. On the right are the following buttons:

• Up moves the element up in the Service View page.

• Down moves the element down in the Service View page.

• Add adds a property, component or layout group to the Service View page as described in Modifying
the Layout of the View Artifact Page on page 40.
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• Edit enables you to edit the name of a sub-heading group or the editable by and visible to attributes
of a property.

• Remove removes the element from the Service View page.

The following page element parameters are displayed in this segment:

DefinitionParameter

The name of the page element as in appears in the SOA Systinet UIName

The type of page element with options:

• Property is a property of the artifact type

• Component is a SOA Systinet UI component

• Relationship is a relationship property of the artifact type

Type

The perspectives that can see this page elementVisible to

The perspectives that can edit this page element in SOA SystinetEditable by

Which extension this property is part ofExtension

• Contextual Actions. These are the options that appear in the context action menus at the top of the
Service View page. On the right are the following buttons:

• Up moves the action up in the list.

• Down moves the action down in the list.

• Add adds a new context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 43.

• Edit enables you to edit the context action with the same parameters as Add functionality.

• Remove removes the action from context action menus.

The following contextual action parameters related to properties are shown in this segment:
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DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

Contextual action identification in the extensionAction

The perspectives that can see this actionVisible to

Which extension this property is part ofExtension

Artifact – Tools UI Tab

The Tools UI tab displays all the attributes of the artifact as they appear in the View Artifact and Browse
Artifact pages in Tools in SOA Systinet and allows them to be amended:

Figure 15. Business Service Editor – Tools UI Tab
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The following segments control its appearance:

• Layout. This is the list of elements and properties of the artifact as they appear in the View Artifact
page in Tools. The elements are organized into groups that match the sub-headings on the View Artifact
page. On the right are the following buttons:

• Up moves the element up in the View Artifact page.

• Down moves the element down in the View Artifact page.

• Add adds a property, component or layout group to the View Artifact page as described in Modifying
the Layout of the View Artifact Page on page 40.

• Edit enables you to edit the name of a sub-heading group or the editable by and visible to attributes
of a property.

• Remove removes the element from the View Artifact page.

The following page element parameters are displayed in this segment:

DefinitionParameter

The name of the page element as in appears in the SOA Systinet UIName

The type of page element with options:

• Property is a property of the artifact type

• Component is a SOA Systinet UI component

• Relationship is a relationship property of the artifact type

Type

The perspectives that can see this page elementVisible to

The perspectives that can edit this page element in SOA SystinetEditable by

Which extension this page element is part ofExtension

• Contextual Actions. These are the options that appear in context actions at the top of artifact pages. In
the Tools UI tab there are two tabs in this segment. Artifact Detail shows the actions for the View

Chapter 8110



Artifact page and Collection shows the actions for the Browse Artifact page. On the right are the fol-
lowing buttons:

• Up moves the action up in the list.

• Down moves the action down in the list.

• Add adds a new context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 43.

• Edit enables you to edit the context action with the same parameters as Add functionality.

• Remove removes the action from context action menus.

The following contextual action parameters are displayed in this segment:

DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

Contextual action identification in the extensionAction

The perspectives that can see this actionVisible to

Which extension this context action is part ofExtension

Artifact – Registry Mapping Tab

The Registry Mapping tab displays any mappings between the artifact and entities in registries and allows
you to create, edit and remove them:
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Figure 16. Business Service – Registry Mapping Tab

It is split into the following segments:

• Artifact Mapping. This is the list of registry entities that represent the artifact in registries. On the right
are the following buttons:

• Add adds a registry mapping as described in Mapping an Artifact Type to a Registry on page 45.

• Edit edits the mapping as described in Mapping an Artifact Type to a Registry on page 45.

• Remove removes the mapping from the artifact.

The following registry mapping parameters are displayed in this segment:

DefinitionParameter

The registry that the artifact type is mapped toRegistry Name

The taxonomy key used to categorize the UDDI entity in the registryTModel Key

The name used to categorize the UDDI entity in the registryKey Name
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DefinitionParameter

The value used to categorize the UDDI entity in the registryKey Value

Which extension this mapping is part ofExtension

• Property Mappings. This is the list of the properties of the artifact and if they are mapped to a registry.
On the right are the following buttons:

• Add adds a new registry mapping for the selected property as described in Mapping an Artifact
Type to a Registry on page 45.

• Edit edits a property mapping as described in Mapping an Artifact Type to a Registry on page 45.

• Remove removes a mapping from the selected property.

The following registry mapping parameters are displayed in this segment:

DefinitionParameter

The name of the propertyProperty Name

The registry that the artifact type property is mapped toRegistry Name

The taxonomy key used to categorize the UDDI entity in the registryTModel Key

The name used to categorize the UDDI entity in the registryKey Name

Which extension this property is part ofExtension

Property Editor

Properties are attributes of artifacts. The property editor allows you to modify the properties in your extension
project. Each property has an editor with the property name as the title containing the following tabs described
in sections:

• Property – General Tab on page 114. The main attributes of the property

• Property – Advanced Tab on page 115. The advanced attributes of the property
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Property – General Tab

The General tab displays the general attributes of the artifact and enables you to modify some of them:

Figure 17. Description Editor – General Tab

This tab contains the following segments:

• General. The following property parameters are displayed in this segment:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the property descriptor in the configurationURI

The description of the property as it appears in the SOA Systinet UIDescription

The plural version of the name as it appears in the SOA Systinet UICollection Display
Name
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DefinitionParameter

A checkbox indicating whether the property is currently active in the extensionDeprecated

• Property Type, Relationship, or Taxonomy. There are three types of property and this segment is
specific to each:

• Property Type. The property type for primitive properties.

• Relationship. This segment displays the source and target artifacts that this relationship links and
some parameters of the inverse relationship. On the right are two sets of two buttons for altering the
source and target artifacts:

• Add selects an artifact in the extension to source or target.

• Remove removes the relationship from a source or target artifact.

• Taxonomy. The taxonomy that contains the available options for this property with Browse to select
a new taxonomy from the extension project.

• Visible to. A list of perspectives with Add and Remove functionality to select which perspectives can
see this property within SOA Systinet.

• Editable by. A simple list of perspectives with Add and Remove functionality to select which perspect-
ives can amend this property within SOA Systinet.

Property – Advanced Tab

The Advanced tab displays the advanced attributes of the property and allows you to modify them:
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Figure 18. Description Editor Advanced Tab

This tab contains the following segments:

• Multiple Cardinality:

DefinitionParameter

If a property has multiple cardinality this parameter is the minimum occurrences of
the property in an artifact

MinOccurs

If a property has multiple cardinality this parameter is the maximum occurrences of
the property in an artifact. Use unbounded if there is no limit.

MaxOccurs

• Default Values:
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DefinitionParameter

An XML extract defining the default valueDefault Value

An XML extract defining default values in the case of multiple cardinalityMultiple Default
Value

• Database Sizes displays optional database sizing for property elements with Add, Edit and Remove
functionality.

Property Group Editor

Properties can be organized into groups. The property group editor allows you to add and remove properties
from a property group. Each property group has an editor with the property group name as the title:

Figure 19. System Properties Editor

The editor contains the following collapsible segments:

• General enables you to change the Display Name and view the URI of the property group.
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• Properties enables you to manage the property group.

On the right are three buttons:

• New creates a new property as described in Creating a Property Group on page 62.

• Add adds a property to the group from the list of available properties.

• Remove removes the selected property from this property group.

The following property parameters are displayed and described in the table below:

DefinitionParameter

The name of the propertyName

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Which extension this property is part ofExtension

Navigation Editor

Navigation actions are the links between pages in SOA Systinet. The navigation editor allows you to con-
figure the left menu and title of SOA Systinet tabs:
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Figure 20. Dashboard Navigation Editor

The editor contains the following collapsible segments:

• General enables you to change the Display Name and Description of the SOA Systinet tab.

• Menu enables you to configure the left menu of the SOA Systinet tab. The navigation items are arranged
into headings and links.

On the right are the following buttons:

• Up moves the selected item up in the menu.

• Down moves the selected item down in the menu.

• Add contains the following options:

• Item adds a navigation item to the menu as described in Adding Navigation Actions to an SOA
Systinet Tab on page 68.

• Component adds a component to the menu as described in Adding Components to a SOA Sys-
tinet Tab on page 69.
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• Group adds a new heading to the menu as described in Adding Navigation Groups to a SOA
Systinet Tab on page 67.

• Edit opens one of the following edit dialogs depending on the item selected:

• Item edits a navigation item with the same parameters described in Adding Navigation Actions
to an SOA Systinet Tab on page 68.

• Component edits a component with the same parameters described in Adding Components to
a SOA Systinet Tab on page 69.

• Group edits a menu heading with the same parameters described in Adding Navigation Groups
to a SOA Systinet Tab on page 67.

• Remove removes the selected navigation item from the SOA Systinet tab menu.

This segment contains the following navigation action parameters:

DefinitionParameter

The name of the navigation item as it is stored in the extensionName

The identification of SOA Systinet UI task invoked by this menu itemTask Location

Item or ComponentType

Which perspectives can see this itemVisible to

Which extension this navigation item is part ofExtension

Portlets Editor

There is a separate portlets editor for each tab within SOA Systinet. These allow you to control which
portlets are available in each tab and where they appear.
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Figure 21. Dashboard Portlets Editor

On the right are the following buttons:

• Add opens the New Portlet Placement dialog described in Adding Portlets to a SOA Systinet Tab on
page 66.

• Edit opens the Edit Portlet Placement dialog for the selected portlet with the same parameters described
in Adding Portlets to a SOA Systinet Tab on page 66.

• Remove removes the selected portlet from the SOA Systinet tab.

The following portlet placement parameters are displayed:

DefinitionParameter

The identification of the portlet in the extensionPortlet Reference

The name of the portlet as it appears on the SOA Systinet tabPortlet Display
Name

There are two options:

• page. The portlet is open in the main area of the SOA Systinet tab

• menu. The portlet is closed but available to add in the left menu

Location Name
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DefinitionParameter

If the portlet is open this specifies which column it appears in on the SOA Systinet
tab

Area

Which extension this portlet is part ofExtension

Components Editor

Components are functional elements which can be added to the SOA Systinet UI.

Figure 22. Components Editor

On the right are the following buttons:

• New opens the New Component dialog as described in Creating a Component on page 81.

• Edit opens the Edit Component dialog with the same parameters described in Creating a Component
on page 81.
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• Remove deletes the selected component from your extension project.

The following component parameters are displayed:

DefinitionParameter

The name of the component as it is stored in the extensionName

The JSP that the component usesPage

The Java class the component usesClass Name

Which extension this component is part ofExtension

Contextual Action Groups Editor

Context actions can be grouped in order to add many actions to a UI element at once. The contextual action
groups editor allows you to create, edit and remove context action groups from your extension project:

Figure 23. Contextual Action Groups Editor

On the right are the following buttons:

• Add contains the following options:
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Action Item adds a context action to a group as described in Adding Context Actions to a Group
on page 75.

•

• Group of Contextual Actions adds a new context action group as described in Creating a Context
Action Group on page 75.

• Edit has the following functions depending on which item in the editor is highlighted:

• For a group you can edit the name.

• For an item the Edit Item dialog with the same parameters as described in Creating a Contextual
Action on page 73.

• Remove deletes the selected context action item from your extension project.

The following contextual action group parameters are displayed:

DefinitionParameter

The name of the action group as it is stored in the extensionName

The reference to the contextual action in the extensionAction

Which perspectives can see this itemVisible to

Which extension this perspective is part ofExtension

Contextual Actions Editor

Context actions are options available in the SOA Systinet UI for artifact and service pages. The contextual
actions editor allows you to create, edit and remove context actions from your extension project:
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Figure 24. Contextual Actions Editor

On the right are the following buttons:

• New opens the New Action dialog described in Creating a Contextual Action on page 73.

• Edit opens the Edit Action dialog with the same parameters as described in Creating a Contextual
Action on page 73.

• Remove deletes the selected context action from your extension project.

The following contextual action parameters are displayed:

DefinitionParameter

The identification of the contextual action as it is stored in the extensionAction ID

The identification of SOA Systinet UI task invoked by this contextual actionTask Location

Which extension this perspective is part ofExtension
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Navigation Actions Editor

Navigation actions are the links available in the menus of SOA Systinet tabs. The navigation actions editor
allows you to create, edit and remove navigation actions from your extension project:

Figure 25. Navigation Actions Editor

On the right are the following buttons:

• New opens the New Action dialog described in Creating a Navigation Action on page 70.

• Edit opens the Edit Action dialog with the same parameters as described in Creating a Navigation
Action on page 70.

• Remove deletes the selected navigation action from your extension project.

The following navigation action parameters are displayed:

DefinitionParameter

The identification of the navigation action as it is stored in the extensionAction ID
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DefinitionParameter

The identification of SOA Systinet UI task invoked by this menu itemTask Location

Which extension this perspective is part ofExtension

Perspectives Editor

Perspectives are the way SOA Systinet controls what users can view. The perspectives editor allows you
to create, edit and remove perspectives from your extension project:

Figure 26. Perspectives Editor

On the right are the following buttons:

• New opens the New Perspective dialog described in Creating a Perspective on page 77.

• Edit opens the Edit Perspective dialog for the selected perspective with the same parameters described
in Creating a Perspective on page 77.

• Remove deletes the perspective from your extension project.

The following perspective parameters are displayed:

DefinitionParameter

The name of the perspective as it is stored in the extensionName

The name of the perspective as it appears in the SOA Systinet UIDisplay Name
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DefinitionParameter

The description of the perspective as it appears in the SOA Systinet UIDescription

Which extension this perspective is part ofExtension

Portlets Definitions Editor

Portlets are the components that appear in the main area of SOA Systinet tabs. The portlets definitions ed-
itor allows you to add, edit and remove portlet definitions from your extension project:

Figure 27. Portlets Definitions Editor

On the right are the following buttons:

• Add contains the following options:

• Feed adds a new RSS feed portlet as described in Creating an RSS Feed Portlet on page 78.

• Portlet adds a new portlet as described in Creating a Portlet on page 78.

• Edit opens the Edit Feed or Edit Portlet dialog for the selected item with the same parameters as Add
functionality.

• Remove deletes the selected portlet from your extension project.
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The following portlet parameters are displayed and described in the table below:

DefinitionParameter

The name of the portlet as it is stored in the extensionName

The type of portlet with options:

• Feed

• Portlet

Type

The identifier for the portlet descriptor in the configurationURI

The SSO partner identificationPartner

Which extension this perspective is part ofExtension

Tasks Editor

Tasks are top level SOA Systinet UI components accessible via their uris. The tasks editor allows you to
create, edit and remove tasks from your extension project.
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Figure 28. Tasks Editor

On the right are the following buttons:

• New opens the New Task dialog described in Creating a Task on page 83.

• Edit opens the Edit Task dialog with the same parameters described in Creating a Task on page 83.

• Remove deletes the selected task from your extension project.

There are the following parameters related to tasks:

DefinitionParameter

The identifier for the taskUri

The component the task usesComponent

A name for the taskCaption

Which extension this task is part ofExtension
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Taxonomies Editor

Taxonomies are category groups that allow you to organize your services. The taxonomies editor allows
the import and removal of taxonomies from your extension project:

Figure 29. Taxonomies Editor

On the right are the following buttons:

• Import imports taxonomies from the active SOA Systinet server.

Note: The referenced SOA Systinet server must be running during import.

• Update refreshes the taxonomy list with any changes from the SOA Systinet server.

• Remove deletes the selected taxonomy from the extension project.

There are the following parameters related to taxonomies described in the table below:

DefinitionParameter

The name of the taxonomy as it is stored in the extensionName
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DefinitionParameter

The taxonomy key identifierTModel Key

Which extension this taxonomy is part ofExtension

project.xml Editor

The project editor allows you to configure your extension project. It contains three tabs described in the
following sections:

• Project – Overview Tab on page 132

• Project – Environment Tab on page 133

• Project – Dependencies Tab on page 135

Project – Overview Tab

The Overview tab enables you to view and amend the basic parameters of your extension project:

Figure 30. Project Overview Tab

The tab contains the following collapsible segments:
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• Project details displays parameters for the extension project:

DefinitionParameter

The name of the extension projectProject name

The project is an extension projectProject type

The workspace folder that contains the extension projectProject location

The last time the project was changedLast modified

• Extension details enables you to configure some of the extension project parameters:

DefinitionParameter

The display name of the extensionName

The version number of the extension projectVersion

A description of the extension projectDescription

The identifier for the extension in the configuration (not editable)URI

The prefix used for the URI when you create a new artifact type or propertyNamespace

Project – Environment Tab

The Environment tab displays the parameters of the SOA Systinet server that the Customization Editor is
configured for:
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Figure 31. Project Environment Tab

This tab contains parameters:

DefinitionParameter

Your SOA Systinet installation folderPlatform Home

The location of the extension folder in your SOA Systinet installationExtension Folder

The URL used to access SOA SystinetServer URL

Indicates if component and JSP development is configured for your extension projectDeploy JSPs

Deployment directory for your JBoss application serverJBoss Deploy Dir-
ectory

JNDI port configured in your JBoss application serverJBoss JNDI Port
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Project – Dependencies Tab

The Dependencies tab displays general information about your extension project and any dependencies
that is has:

Figure 32. Project Dependencies Tab

The tab contains the following segments:

• Extension dependencies displays a tree of extensions that the extension project is dependent on.

• Project and extension general information displays parameters of the extension project:

DefinitionParameter

The name of the extensionName

The version number of the extension projectVersion

A description of the extension projectDescription

The identifier for the extension project in the configuration (not editable)URI

The creation date and time of the extensionBuildtime

Messages View

The Messages view tracks the changes that you make to extension entities and displays any warnings and
problems that may occur as a result of those actions:
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Figure 33. Messages View

Double-clicking an item in the tree opens the relevant editor for that object.

Search View

The Search view displays the results of a search (see Searching the Extension on page 30) or find usage
query (see SDM Details on page 25):

Figure 34. Search View

The results are shown as a tree of artifact types, properties and property groups containing the requested
item.

Double-clicking an artifact type, property or group opens the relevant editor.
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